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2. Important User Information

Thank you for using EKO Products

Make sure to read this instruction manual thoroughly and to understand the contents before starting to operate the
instrument. Keep this manual at safe and handy place for whenever it is needed.

For any questions, please contact us at one of the EKO offices given below:

2-1. Contact Information

EKO INSTRUMENTS co., LTD.

Asia, Oceania Region

EKO INSTRUMENTS Co., Ltd.
1-21-8 Hatagaya, Shibuya-ku Tel: +81 (3) 3469-6711
Tokyo, 151-0072 Japan Fax: +81 (3) 3469-6719

www.eko.co.jp
info@eko.co.jp

Europe, Middle East, Africa, South America Region
EKO INSTRUMENTS Europe B.V.
Lulofsstraat 55, Unit 28, Tel: +31 (0)70 3050117
2521 AL, Den Haag, The Netherlands Fax: +31 (0)70 3840607

www.eko-eu.com
info@eko-eu.com

North America Region
EKO INSTRUMENTS USA Inc.
111 North Market Street, Suite 300 Tel: +1 408-977-7751
San Jose, CA 95113 USA Fax: +1408-977-7741

www.eko-usa.com
info@eko-usa.com

2-2. Warranty and Liability

For warranty terms and conditions, contact EKO or your distributor for further details.
EKO guarantees that the product delivered to customer has been verified, checked and tested to ensure that
the product meets the appropriate specifications. The product warranty is valid only if the product has been

installed and used according to the directives provided in this instruction manual.

In case of any manufacturing defect, the product will be repaired or replaced under warranty. However, the
warranty does not apply if:
» Any modification or repair was done by any person or organization other than EKO service
personnel.
»  The damage or defect is caused by not respecting the instructions of use as given on the product

brochure or the instruction manual.
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2-3. About Instruction Manual

Copy Rights Reserved by EKO INSTRUMENTS CO., LTD. Making copies of whole or parts of this
document without permission from EKO is prohibited.

This manual was issued: 2019/07/29

Version Number: 5
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3. Safety Information

EKO Products are designed and manufactured with consideration for safety; however, please make

sure to read and understand this instruction manual thoroughly to be able to operate the instrument

safely in the correct manner.

WARNING Attention to user; pay attention to the instructions given on the

CAUTION instruction manual with this sign.

HIGH
TEMPERATURE Touching or getting close to the devise may lead to burn.
WARNING

LOW

TEMPERATURE Touching or getting close to the devise may lead to frostbite.
WARNING

A 3-1. WARNING

1. Setup and Operation

> Installation base or mast should have enough load capacity to set the Grating Spectroradiometers

MS-713. Fix MS-713 securely to the base or mast with bolts and nuts. Carefully install the
computer as well. The instrument/computer may drop due to gale or earthquake and vibration,
and may invite unexpected accidents.

Do not use this instrument in different use other than its original purpose.

Do not disassemble, modify or touch inside this instrument.

Do not place this instrument in places where humidity and/or dusts exist, extreme difference in
temperature of over specification range, near object which emits strong magnetic energy or electric
wave. These conditions may cause damages to the instrument.

>  Make sure to install this instrument where maintenance can be performed safely.

»  Ventilation unit is attached to this instrument. Touching this instrument while the ventilation is
running, it may lead to accidents and injury. Turn off the power before touching the ventilation

unit.

2. Power Supply
» Do not touch the terminals and power plug with wet hands. This will lead to electric shocks and
leakages.
»  Check the voltage and provided power type (AC, DC) to make sure they are suitable for the
instrument specification before turning the power on.

>  Use only the attached cables. Using any other cables may lead to electric shocks or leakages.
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EKO Instruments will not be held responsible in case of accidents or measurement accuracy by
using cables other than specified by EKO.

3. Handling

»  Hold the bottom part of the instrument firmly when carrying this instrument.

» Holding the cover, glass dome or any other part of this instrument can lead to damage or dropping

instrument.

»  Be careful with handling the glass dome.

& 3-2. HIGH/LOW TEMPERATURE WARNING

& 1.Temperature of the Sensor Part

»  The spectrometer inside this instrument is temperature controlled to enhance the measurement

accuracy. Therefore, the housing of this instrument becomes higher or lower than the outer

temperature. Always use gloves for when touching the housing; touching with bear hands may
lead to burn or frostbite.
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4.

Introduction

The Grating Spectroradiometer MS-713 is developed for measuring solar spectrum outdoor, and it is a unique all

weather concept instrument which can be used in various fields such as meteolorogy, photovoltaic and agriculture.

Solar spectrum changes various ways depending on the season, the time of day, and the regional air mass and
atmospheric composition. In response to changes in the spectrum, the power generation performance of
multi-junction solar cells such as concentrating solar cells significantly change, and the growth conditions of crops
differ. Detailed and quantitative understanding of the sunlight spectrum using a spectroradiometer makes it

possible to analyze the relationship between device performance, crop growth, etc. and the spectrum.

MS-713 can measure the near infrared region in the wavelength range of 900 nm to 2,500 nm.
By using MS-713 in combination with MS-711, it is possible to seamlessly measure a broad wavelength range from
300nm to 2,500nm (MS-711 has a visible/ near infrared region between wavelength range of 300nm and 1,100nm,

MS-713 measures the near infrared region from wavelength 900nm to 2,500nm.)

MS-713 has succeeded to control the temperature of the spectrometer at constant to suppress the temperature
change in spectrometer, which will greatly affects the measurement uncertainty, allowing maintaining a high
performance over a wide operation temperature range. In addition, MS-713 is has better resistances to mechanical
vibration and external force compared to optical fiber type spectrometer due to optimal designs of diffuser and
optical components. Therefore, it provides improved stability for continuously measuring outdoor, and excellent

robustness in transportation for cyclic measurements.

MS-713 have a separate power supply and can be controlled through RS232 / 422 by a PC or data logger. The PC

software provide different fuctions for operating, data management and visualisation.
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4-1. Main Features

1. All-Weather

Using our technology cultivated through the design, manufacture and sale of weather observation equipment
used outdoors such as pyranometers, we also have our grating spectroradiometers as all-weather products.

MS-713 can be used for a long-term outdoor measurement.

2. Wide Measurement Range
By combining the MS-711 (300nm to 1,100nm) and MS-713(900nm to 2,500nm), it is possible to measure a

wide wavelength range from 300nm to 2,500nm.

3. Operating Software

The operating software has different measurement functions, to make either a “single measurement” or
“scheduled measurement” which takes periodical measurements every day.

This software allows to display multiple spectral data in one graph, as well as to review details of one spectral
data and so on.

These software have the functions of resampling and saving the wavelength interval of spectrum data every 1
nm, automatically calculating various operation values, and combining with the spectrum data of MS-711 and

MS-713.
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4-2. Package Contents

Check the package contents first; if any missing item or damage is noticed, please contact EKO immediately.

Table 4-1. Package Contents

Standard Items | Qty. ‘ Remarks

Sensors 1

Power supply unit 1

Set of Sensor fixing screws 1 Bolts: M8 x 230, Washers, Nuts (2pcs/set)

Fuse (for spare) 2 $5.2x20, 250V, 2A

Sensor cable 1 Standard Length : 10m

Ventilation power supply cable 1 Standard Length : 10m

AC Adapter 1 Cable length : 1.5m

AC power supply cable 1 Length : 2m

RS-232C cable 1 Length : 1.5m

CD-ROM 1 Software (WSDac_V5.0.x.x.exe and WSDisp_V5.0.x.x.exe)
Instruction Manual

Calibration Certificate 1

Instruction Manual 1
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4-3. Consumable Items

MS-713 contains following consumable items.

Table 4-2. Consumable Items

These items are not covered under warranty.

Standard Items | Qty. ‘ Remarks
Silica Gel Approx. | Particle size: 2 to 3mm
69 Replace when the color changed to red.
Fuse 1 $5.2x20, 250V, 2A
[Specification of Ventilation]
Model: 9WG1212H101-E
Manufacturer: SANYO DENKI
Size: 120 x 120 x 38mm
Rated voltage: 12V
Rated current: 0.38A
Maximum air flow: 2.8 m3/min.
Ventiation . Maximum static pressure: 70.4 Pa

Expected Life: 100000hr / 60°C

IP Class: IP55

No ribs

Frame Materials:  Aluminum
[Specification of Terminal]

Housing Model: 03T-JWPF-VSLE-S

Contact Model: SWPT-001T-P025

Manufacturer: J.S.T.MFG.CO.,LTD.
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5. Getting Started

5-1. Parts Name and Descriptions

Each part name and its main functions are described below.

Table 5-1 and Figure 5-1 describe the sensor parts, and Table 5-2 and Figure 5-2 describe the power supply parts.

1. Sensor

Table 5-1. Names and functions of Sensor Part

NET e Function
» Used for leveling the sensor base horizontally, adjust the two leveling screws to
1 | Spirit Level ) .
place a bubble in the center of the circle.
2 | Fixing Holes Used for fixing the instrument in leveled position.  Fix the sensor for safety.
3 | iff The diffuser diffuses the incident light from sky hemisphere, and it compensates the
iffuser
intensity of the incident light to comply with cosine characteristics.
Dome protects the sensor inside from soiling and effects from rain and wind, and it
4 | Quartz Dome . . o .
enhances the cosine characteristics which incident from the sky hemisphere..
5 Sensor/Power Supply | Connect Sensor/Power Supply Cable. Transmit power signal from power supply
Cable Connector to sensor. Connector part is waterproofed.
) . Used for keeping inside the sensor dry. It is necessary to replace it periodically
6 | Drying Cartridge .
when the desiccant color change.
7 | Cover Prevents from sensor’s internal temperature increasing by solar radiation.
. To set the sensor in horizontal position, adjust 2 screws as monitoring the spirit
8 | Leveling Screws
level.
o | Heatsink Effectively releases the heat generated during temperature controlling the
eatsin
spectrometer inside the MS-713.
. Effectively releases the heat generated during temperature controlling the
10 | Waterproof Ventilation o
spectrometer inside the MS-713.
Ventilation Power o
11 Connect ventilation power supply cable
Supply Connector

\A‘:‘

Figure 5-1. Parts Name and Function (Sensor)
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2. Power Supply

Table 5-2. Names and functions of power supply

| Name

1 | Power Switch

Function

When the power switch is pushed to right side, power is ON, to left side power is

OFF.
2 | Connector Strip Block
Terminal block ‘ Wire Color ‘ W#itre
1 TXD+(RS-422) Brown 1
2 TXD-(RS-422) Red 2
3 RXD+(RS-422) Orange 3
4 RXD-(RS-422) Yellow 4
5 Digital GROUND Green 5
6 Supply power +5V Gray/Blue 6
7 Supply power ground Whi(t;;/e\;erilow 7 (DC GND)
8 Peltier Control +16V Black 8
9 Peltier Control Ground Pink 9 (DC GND)
10 EARTH Black 10

3 | Connector for PC

Connect RS-232C cable to PC.

4 | Fuse Holder

Set 2A fuse.

5 | AC Power Connector

Voltage range is AC100 to 240V, frequency is 50 / 60Hz.

6 | Grounding Terminal

Use this terminal when AC power supply is not grounded.

L]
@®
\ f/@
@ \ﬂ:] O da
o o e
®
 — | —

Figure 5-2. Parts Name and Function (Power Supply Part)
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5-2. Setup Location

1. Location

In order to obtain representative measurements from spectroradiometers, several criteria with respect to

setup and mounting of the instruments have to be considered*:

The ideal mounting position for the spectroradiometer is a location which has a full hemispheric field-of-view
without any obstructions (such as buildings, trees, and mountain). In practice, it might be difficult to find such
locations. Therefore, some practical recommendations on how to minimize undesired effects of reflecting or
obstructing surfaces are given next:
e Select a mounting position which it is free from obstructions at 5° above horizon.
e The setup location should be easily accessible for periodic maintenance (quartz dome cleaning,
desiccant replacement, etc.).

e Avoid surrounding towers, poles, walls or billboards with bright colors that can reflect solar radiation

onto the spectroradiometer.

2. Installing at Horizontal or tilted Positions

(1) Prepare Installation Base
Check the installation base where the MS-713 has to be mounted and make sure it has two fixing holes

with the appropriate pitch. The pitch sizes of the fixing holes are as follows (in mm):

Table 5-3. Fixing Hole Pitch and Bolt Size

Fixing Hole Pitch 280mm 2-910

Fixing Hole

Fixing Bolt Size M8 x 230mm

205

D240

Figure 5-3. Dimension
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(2) Setup the MS-713 Sensor
Setup the sensor with the signal cable connector facing the nearest Earth’s pole.
In the Northern hemisphere, the connector should be orientated North, in the Southern hemisphere,

the connector should be orientated South.

(3) Leveling

Adjust the sensors in a horizontal position by using the 2 leveling screws and observing the air
bubble in the spirit level while manipulating the leveling screws. The instrument is leveled
horizontally if the air bubble is in the center ring. Once the instrument is leveled properly, fix the
instrument with mounting bolts.

In case the sensor is mounted on a tilted plane, preferably the sensor is mounted on the leveling
screws to thermally isolate the sensor form the mounting platform.

If the sensor is not leveled properly, the readings are affected by cosine and azimuth errors.

Periodically check the spirit level and adjust its position if necessary.

(4) Adjust Height
To take measurements by setting up the MS-713 side by side, the sensor surface must be adjusted

to the same height level.

(5) Cover

Place the Cover on the instrument and fasten with 3 screws (M3).

(6) Connect Sensor Cable
Connect the sensor cable connector to the sensors and the Y-terminals to the terminal block of the
power supply according to the table below.
Make sure the sensor connector part is securely connected so that moisture will not enter the
connector.  Also fasten the cable with such as band strip so that it will not be blown by wind
If the sensors are setup on Sun Tracker, make sure to have sufficient length of cable for rotation
movement.
Use + screw driver to connect the cable to lug terminals on the power supply, make sure the cable

numbers and the terminal numbers match.

NOTE: The power supply can't be used in an unprotected outdoors environment, as it can only be

used in a dry environment.

Table 5-4. Terminal block layout and Wire colors

Terminal block Wire # ‘

1 TXD+ (RS-422) Brown 1
2 TXD- (RS-422) Red 2
3 RXD+ (RS-422) Orange 3
4 | RXD- (RS-422) Yellow 4
5 Digital GROUND Green 5
6 Supply power +5V Gray/Blue 6
7 Supply power ground Whger/e\;er:low 7 (DC GND)
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8 Peltier Control +16V Black 8
9 Peltier Control Ground Pink 9
10 EARTH Black 10

(7) Connect Power Supply

(DC GND)

Connect the one end of power cable to AC power supply connector at the rear of power supply. Then

connect the other end of power cable to the socket properly. Make sure that provided power is
AC100-240V, 50/60Hz, 50VA.

(8) Connect Communication Cable

Connect the PC COM port and the RS-232C connector at the back of the power supply with

RS-232C cable.

When connecting, insert the connector which has ferrite core to the power supply.
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6. Software

This software is exclusively used for measuring and processing the data acquired by MS-713. It is used for taking

measurements and analyzing data. Below describes the system configuration.

MS-713 [WSDac_V5.0.x.x.exe]
= RS422 RS232C | Measurement Software
Power f [WSDisp_V5.0.x.x.exe]

Supply Data Analysis Software

WSD file CSV file
Figure 6-1. Outline of Software

6-1. Installation and Uninstallation

1. Installation

NOTE: Make sure to install the software on a PC which has administrative and/or installation authority.

1) Power ON the PC and insert the installation disk to the CD disk drive while the Windows desktop screen
is displayed.
2) Start the installer by clicking the “Setup.exe” which is included in the Installation Disk.

3) Installation Wizard window appears. To go to the next step, click [Next].

12} MS-713 Software WSDac_5021 & WSDiap_5020 - InstallShield Wizard (mzm]

Welcome to the InstallShield Wizard for
MS-713 Software WSDac_5021 &
WSDiap_5020

The InstallShield(R) Wizard will install M5-713 Software
WSDac_5021 & W5Diap_5020 on your computer, To continue,
dlick Mext.

WARMING: This program is protected by copyright law and
international treaties.

< Back [ o pexts [ Cancel ]

Figure 6-2. Installation Wizard Startup Window
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4)

5)

NOTE: When changing the installing folder, User Account Control function becomes active.

“License Agreement” window appears; select “I accept the terms

[Next] button to go to the next step.

in the license agreement” then click

‘_‘5 M5-T13 Software W5Dac_5021 8 WSDiap_5020 - InstallShield Wizard

License Agreement

Please read the following license agreement carefully.

Software License Agreement

This agreement provides prerequisites for the

() 1 do not accept the terms in the license agreement

InstallShield

software

mentioned below between the User and EKO Instruments Co., Ltd.
("EKO").
The zoftware includes the software attached to EKO products and the
software program ("Software") mentioned in this agreement. Do not
install or use the Software until you have read and accepted all of the
license terms.

use

[ < Back ][ Mext =

] [ Cancel ]

Figure 6-3. License Agreement Window

“Destination Folder” window appears.

If the software will be installed in the “C:\EKO” folder, click [Next]

button to go to the next step. To change the destination folder, click [Change...] button and select the

appropriate folder.

‘@ M5-T13 Software W5Dac_5021 & WS5Diap_5020 - InstallShield Wizard

Destination Folder
Click Next to install to this folder, or dick Change to install to a different fold

&

Install M5-713 Software WSDac_5021 & WSDiap_5020 to:
C:\EKOWMS-713)

InstallShield

[ < Back || Mext =

| [ Cancel

Figure 6-4. Destination Folder Window

Installing

and/or data uploading in the folder which OS is restricting the access authority may generate

problems.
folder “C:\” for such folder with restrictions.

folder.

There are “C:\Program Files”, “C:\ProgramData”, “C:\Windows”, and system drive route

Avoid these folders when changing the destination

EKO INSTRUMENTS CO., LTD Grating Spectroradiometer MS-713 Instruction Manual Ver5
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6) “Ready to Install the Program” window appears. Confirm the destination folder and if okay, click

[Install] button to go to next step.

15} MS-713 Software WSDac_5021 & WSDiap_5020 - InstallShield Wizard (23]

Ready to Install the Program
The wizard is ready to begin installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Current Settings:

Setup Type:
Typical
Destination Folder:
C:\EKOWMS-713),

User Information:
Mame: Eko-Ot
Company:

InstallShield

[ <pack | Hiinstal | [ Cancel

Figure 6-5. Install Window

7) After a while, the PC display goes dark and “User Account Control” dialog window appears. Click [Yes]

button to start the software installation.

@ User Account Control @

Do you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name:  Ch\Users\Eko-Qt\AppData'\Local\Downloaded
Installations\[4ECBB7AG-AD5B-4993-8F0B-B...\M5-T13
Software WS5Dac_5021 & WSDiap_5020.msi

Publisher: Unknown
File origin: Hard drive on this computer
(%) Show details Yes || No |

Change when these notifications appear

Figure 6-6. User Account Control Window

8) As the installation is completed, the following window appears. Click [Finish] button to close the

installation window.

13! MS-713 Software WSDac_5021 & WSDiap_5020 - InstallShield Wizard (==

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed M3-713
Software WSDac_5021 & WSDiap_5020. Click Finish to exit the
wizard.

Figure 6-7. Installation Complete Window
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9)

When the installation is completed, a shortcut icon as shown below will be created on the desktop, as

well as under the Start Menu, “All Programs” - “EKO” - “WISER”".

=M=
td kd

WSDac_5021 WSDisp_5020
Figure 6-8. Software Shortcut Icon

2. Uninstallation

There are 2 ways to uninstall the software.

1)

Uninstalling from the “Programs and Features”

Access by clicking “Control Panel” - “Program and Features”. Select the program to be uninstalled

and right click; the popup menu will appear. Select “Uninstall”.

@U?‘B » Control Panel » All Control Panel Items » Programs and Features

Control Panel Home .
Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or Repair.

'E‘:" Turn Windows features on or

i Organize =  Uninstall Change  Repair
MName ° Publisher Installed On  Size
£ MS-713 Software WSDac_5021 & WSDiap_5020 EKO 7/17/2019 384 KB
] T}
EKO Product version: 5.0.1.0 Support link: http://eko.co.jp
Help link: http://eko.cojp Size: 384 KB

B= -

Version

5021

(7]

~

Figure 6-9. Uninstalling from “Programs and Features”

Following message appears; to uninstall, click [Yes] button. The software will disappear from the

“Programs and Features” list and confirms the software has been uninstalled.

g User Account Control @

O Do you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name:  Ch\Windows\Installer\128307 msi

Publisher: Unknown
File origin: Hard drive on this computer
() Show details ves || No

Change when these notifications appear

Figure 6-10. User Account Control Window
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2)

Proceed according to the messages appear on the window.

Uninstalling from Installation Disk

Just like when the software was installed, startup the software to be uninstalled from the CD-ROM.

appear the options as “Modify”, “Repair” and “Remove”.
Select “Remove” from this window and click [Next] button.

Follow the messages on each step will result in uninstalling the software.

‘ﬁ M35-713 Software WSDac_5021 & W5Diap_5020 - InstallShield Wizard

Program Maintenance

Modify, repair, or remove the program.

) Modify

Change which program features are installed. This option displays the
Custom Selection dialog in which you can change the way features are
installed.

Repair installation errors in the program. This option fixes missing or
corrupt files, shortcuts, and registry entries.

Remove M5-713 Software WSsDac_5021 & WSDiap_5020 from your
computer.

InstallShield

[ < Back ][ Next = ] [ Cancel

Figure 6-11. Uninstalling from CD-ROM

If the software is already installed, there
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6-2. Data File Format

The following data file formats are available for this software.

Table 6-1. File Format

File format Binary/ASCII Wavelength increment
a ESM file Binary Specified as spectroradiometers
Specified as spectroradiometers
CSV file ASCII ]
c 1nm interval

1. WSD File (Binary Data)

WSD format data file is composed as binary data. Only the spectral radiation data of the wavelength interval

according to spectroradiometers specifications is saved in WSD file.

2. CSV File (ASCII)

CSV file is composed as ASCII format data. The spectral radiation data of wavelength interval according to
the spectroradiometers specification can be saved in CSV file, as well as the spectral radiation data which
wavelength interval sampled at 1nm. The CSV file data is easily converted to other formats, including

Microsoft Excel.

[Measured Value of CSV Data File and Calculated Value of CSV Data File]
This software can save the CSV data file of measured value which radiation is output for each wavelength, as

well as the CSV data file of calculated value which output the calculation result.

[Measured Value of CSV Data File]
Radiation data of each wavelength is saved. This file contains the instrument data (MS-711, MS-712,
MS-713, or Merge) which is selected ahead of time. See “CSV Format Data” in section “7-2 Before Starting

Measurements”
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Table 6-2. Example of Measurement Value of CSV Output (Original Wavelength Pitch):
Common for WSDac and W SDisp

A Measured Date
Data 2018/12/20 2010/12/20 I
Time 9:00:00 9:01:00 2 Measured Time
Memo EKO WISER —
| Data Memo
Sensor MS-711 MS-713 MERGE MS-711 ~
Exposure 500 30 500 j Instrument
Time(msec) \ :
I Exposure Time
Sensor 25 25 24.7 -
Temp.(deg) S Internal
Temperature
Power[V] 5.9 5 5.9 ~— :
—
Wavelength Irradiance Irradiance Irradiance Irradiance Applied Voltage
(nm) (W/m?/um) (W/m?/um) (W/m?/um) (W/m?/um)
946.53 119.71 124.6 125.9
947.31 110.3 127.99 93.65
947.83 131.61 131.52
948.1 140.11 132.52 133.84
132.65 13393 [\~ 13054
\ 1 7 AN T~
Measured MS-711 MS-713 Merged Data acquired in one time

Wavelengths

Radiation Data

Radiation Data

Radiation Data

measurement (Marked Blue)

[Calculated Value of CSV Data File]

The calculated value of CSV data file can be saved with data such as PAR (Photosynthetically Active
Radiation), PPFD (Photosynthetic Photon Flux Density), ILLUMINANCE, Integral (interval integrated value)

that are calculated out from the data in each calculated intervals.

The PAR/PPFD are calculated from the

data between 400 to 700nm and llluminance is calculated by multiplying the standard relative luminosity

curve to the data between 380 and 780nm.

the specified wavelength interval.

interpolated with 1nm pitch.

Table 6-3. Example of Calculated Value CSV Output, only WSDisp

2010/5/8
Time PAR(W/m?) | PPFD(umol/m?/s) ILLUMINANCE(IX) | Integral[300-1800](W/m?)
7:00:00 25.49 117.8 5935.9 138.2
7:01:00 255 117.8 5937.1 139.5
ﬁo 25.46 7.7\ 5931,2 13:]\\
N NN N N——
Measured PAR PPFD ILLUMINANCE Radiation Integrated
Date & Time Data Data Data Data

Integral (interval integrated value) will be the integrated value in

Either one will be the calculation result of data which was linearly
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7. Measurement Software (WSDac)

WSDac.exe is measurement software, and it has main function of data measurement, including the scheduled
measurement.

Scheduled measurement takes measurement automatically repeated daily at a certain time frame and in time
interval which are setup in advance then save the data in WSD file. In each data measurement, the most

appropriate exposure time is automatically setup by the software and takes and save the spectrum data.

NOTE: When taking measurements by switching multiple units of MS-713 on one computer, make sure to
do the following:

- Restart the software each time the instrument is switched. If the software is not restarted, the
calibration value saved from the previous measurements will be used, and the measurement will not
be accurate.

- Change the folder for saving. With this software, the multiple data of the same model type
instrument cannot be saved in a same folder.

NOTE: To use the merge function in data analysis software for the measured data, measurement should
be taken with one of the following combination using WSDac.

»  MS-711 + MS-712

» MS-711 + MS-713

»  MS-710 + MS-712

»  MS-710 + MS-713

7-1. Starting Measurement Software WSDac

As the “WSDacV3.0.x.x.exe” is started, the Fig.7-1 Window is displayed.

1 WSDac EI@

Eile Measure View Help

el ==

FradanceiW/m2 um)

Wavelzngth fnm)

Ready MNUM

Figure 7-1. WSDac.exe Main Window
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7-2. Before Starting Measurement

Before starting the measurement, setup the measurement condition.

Go to [Measure > Measurement

Settings] from the tool bar or click the [Configuration] button located at the top (Figure 7-2) then the

[Measurement Settings] window will be displayed as shown on Figure 7-3.

o 21 WSDac
Configuration _ :
File Measure View Help
Button : :
B3 BB &S T
Figure 7-2. Configuration Button
Measurement Settings
—COM Port User Comment
™ Ms-T10 | -.-I J
IEKD WISER —_ User Comment
v M5-711 I vI
COM Port [ msT12 I 'I Integration Range({nm})
t N Integration
Setup wus7ms [ | || From |200 51800
_ Range Setup
Measurement — Measurement Time
Time Setup "\ = = = = I__jﬁ
StElrtIE I II} —~1 Finishlzl};[: ID -] Ewery 10 _-| minutes
Save Folder for WSD Format data
Binary Format > File Name:™"y""Y MMDD.wsd™ (Daily)
I CAEKOWS-T13\ T |
CSV Format data Wavelength
Save Checkbox )
v Save - File Name: ™™ ™™ MMDDhh.csv™ (Hourhy) Range to be
~Wavelength Interval Wavelength Range(nm) saved in
Wavelength r 24 CSV Format
. From To T
Pitch to be
saved in CSV —Data Selection Select Data to
Mws70 T wsl [T wMs712 [ wms713 [ Merge | be saved in
CSV Format
CARKOWS-T134 Brow Folder Location
Auto-Start After
for saving CSV
Software
Format Data
Starting Auto-Start aﬁgr
Software Starting OK Cancel
Checkbox

Figure 7-3. Measurement Setup Window
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Table 7-1. Measurement Setup Window Functions

Functions

[COM Port Setup]

Description

Select a COM Port which is connected to the instrument to be controlled.

[User Comment]

Save the measurement data with attached memo which is entered in this box.

[Integration Range]

Indicates the specified integration value interval on the measurement data graph
window.

[Measurement Time]

Measurement will be taken in the specified interval during the measurement start
time to the end time.

[WSD Format Data]

A folder can be selected to save the Binary format spectrum data. Click [Browse]
button to select a folder for data to be saved. When the data is taken, the file
name will be saved with the measured date [YYYYMMDD.WSD] (YYYY: Year, MM:
Month, and DD: Day)

[CSV Format Data]

A folder can be selected to save the CSV format spectrum data.

[Save] Checkbox

By checking this checkbox, measurement data in each time interval are saved in
CSV formatfile. The file name will be the date and time of the measurement, such
as [YYYYMMDDhh.WSD] (YYYY: Year, MM: Month, DD: Day, and hh: Time).

Wavelength Pitch

By selecting the “Raw”, the data is saved with the unique wavelength pitch of the
instrument itself. By selecting “1nm”, the data is saved as linearly interpolated in
1nm pitch.

Wavelength Range

The data will be saved in CSV format data in the wavelength range which is
specified; this is effective only when the Wavelength Pitch is setup with “1nm”.

Data Selection

Saves the data of the instrument which is selected. When measuring the MS-711
and MS-713 at the same time, the combined data of MS-711 and MS-713 can be
saved by selecting “Merge.”

Folder for Saving
CSV Format Data

Click [Browse] button to specify the folder for data to be saved. For CSV format file
will create a Year folder [YYYY] automatically under the specified folder to save the
data.

[Auto-Start After Software
Starting]

By checking the checkbox, the measurement will be automatically started as the
software is started up with the condition setup in the last measurement condition.

When clicking [OK] button shown at the bottom of the window, the data save folder setup is completed.
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7-3. Start Measurement

There are Manual Measurement, which takes just one measurement, and Interval Measurement, which takes
measurement by specified interval.

To start a manual measurement, go to [Measure - Start Manual Measurement] from the tool bar or click the
[Manual Measurement Start] button located at the top (Figure 7-4); the [Manual Measurement Running]
window is displayed as shown on the Figure 7-5.

To start Interval Measurement, go to [Measure - Start Interval Measurement] from the tool bar or click the
[Start] button (Figure 7-6) located at the top; the [Interval Measurement] window is displayed as sown on

Figure 7-7.

Manual Measurement File Measure Wiew Help
Start Button = ‘:B‘ E % ?

Figure 7-4. Start Button

Manual Measurement

T 2019/02/02 133952 \|

>MS711 READY
MS713 READY

Current Time

Terminate Manual
Measurement Button

Instrument Status

—\ L

Figure 7-5. Interval Measurement Window

File Measure View Help

Interval Measurement
Start Button = @ E % ?

Figure 7-6. Start Button

Manual Measurement

PN S9/02/02 133052 \| Terminate Interval

Current Time

Measurement Button

>MS711 READY
MS713 READY

Instrument Status

e Y =

Figure 7-7. Interval Measurement Window

Table 7-2. Measurement Start Functions

Functions ‘ Descriptions

Current Time The current time is displayed.

Instrument Status The statuses of the measuring instruments are displayed. The Table 7-2
describes the meaning of each message and status, and how to deal with the
statuses.

Abort Button Terminates the manual or interval measurement.

EKO INSTRUMENTS CO., LTD Grating Spectroradiometer MS-713 Instruction Manual Ver5 Pg. 26



Table 7-3. Messages Displayed on the Interval Measurement Dialog Window

Messages

Error (Opening COM Port failed)

‘ Statuses

Cannot open the setup
communication port.

Actions ‘

Check the measurement settings.

Getting the sensor information

Software retrieving the sensor
information. Normal condition

No action necessary

Error (Communication with the
sensor failed)

No responses from the instrument

Check the communication cable
and power supply of the instrument.

Error (Getting the sensor
information failed)

Error (Getting the calibration value
failed)

The communication is unstable.

Check the communication cable for
disconnection and cable condition.

Error (Sensor Name)

A sensor which is different from the
setup is connected.

Check the communication port and
the corresponding instrument.

READY

Completed the measurement
preparation.

No action necessary.

Measuring

Displayed during the measurement
is taken.

No action necessary.

Retrying measurement

The measurement failed, but
retrying to start measurement.

Measurement failed

Displayed when the measurement
is retried for 3 times and
measurement failed.

Check communication cable and
power supply of the instrument.

Measurement OK

Measurement was done

successfully.

No action necessary.

Application Log File (YYYY(Year).LOG)

The YYYY(Year).LOG file is created in the same folder as WSD files saving folder, which was setup in the

measurement setup for Measurement software WSDac.

This file records the information such as

application start-up, measurement start, measurement error, file processing error. (Table 7-3)

Table 7-4. Contents Indicated in Application Log File

Message ‘ Condition

APP START

Measurement Software startup

APP CLOSE

Measurement Software exit

INT.MEAS START

Started Interval Measurement

INT.MEAS STOP

Ended Interval Measurement

ERROR MEAS THREAD CREATE

Internal Error (Measurement Thread startup failed)

ERROR WSD LOAD

Existing WSD file uploading for adding data failed

ERROR MS710 MEAS

MS710 Measurement failed.

ERROR MS711 MEAS

MS711 Measurement failed.

ERROR MS712 MEAS

MS712 Measurement failed.

ERROR MS713 MEAS

MS713 Measurement failed.

ERROR WSD SAVE

WSD File Saving failed.

ERROR CSV SAVE

CSV File Saving failed.
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7-4. Measurement Data Display

By taking a measurement, the Measurement Data display window shows the graph (Fig. 7-8). This graph is

updated per each measurement.

EEIX

File Measure Wiew Help User Comment

el = I = = N Range of
\

Integration Value

Instrument
Information

Measured Date & Time FKO WISER.

Trzaidinme of "Woan®

"

Ready

Figure 7-8. Measurement Data Display Window

Table 7-5. Measurement Data Display Functions

Functions ‘ Descriptions

[Measured Date & Time]: The date and time of the displayed measurement taken.
Displays the [User Comment] entered in the Measurement Setting.

[User Comment]:
[Range of Integration | Displays the spectrum radiation integration value (W/m?) within the wavelength

Value]: range which is setup in [Integration Range] in the Measurement Setting.

[Instrument Information]: | Displays the information of [Buildup Time (Exposure Time)], [Sensor Temperature],
[Power Supply Voltage], and [Sensor Cooler Drive (MS-712 or MS-713)]
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7-5. Graph Setting

When specifying the graph axis and color of line on the displayed graph, use the [Graph] button. Either go
to [View - Graph Settings] from the tool bar or click the [Graph] button (Figure 7-9) located at the top, the

[Graph Settings] window will display as sown on Figure 7-10.

File Measure Wiew Help
=N

Figure 7-9. Graph Button

Graph Button

Graph Settings

YA xis
Y-Axis Setting L Graph Color
T2l e —
Frame Color Graph Color

H-Axiz[nm] Frame Color
- Grid Line

——
From |3I:":I To | 100 [+ Gid Line

X-Axis Setting L
r

Ok | Apply Cancel |

Figure 7-10. Graph Settings Window

Table 7-6. Graph Setting Functions

Functions ‘ Descriptions

[Y-Axis Setting]: By checking the “Auto” checkbox, the Y-Axis scale is automatically setup. By
removing check from the “Auto” checkbox, the maximum value of Y-Axis can be
specified

[X-Axis Setting]: Specify the X-Axis wavelength range to be displayed on graph.

[Graph Color, Frame By clicking the colored area, the color selection dialog window will be displayed,

Color, and Grid Line]: and the graph and frame color can be specified as desired. The grid line of the
graph can be shown or not shown by checking or un-checking the [Grid Line]
checkbox.

[OK, Apply, Cancel] By clicking the [OK] button, the Graph Setting window will disappear and go back

Buttons: to the graph display window.

Clicking [Apply] button will allow the user to see the changes on the graph with the

Graph Setting window still opened.

[Cancel] button can cancel the setting changes on the Graph Setting.
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7-6. Graph Copy

This function copies the graph image displayed on the window on to clip board. Go to [View - Copy] from

the tool bar or click the [Copy] button (Figure 7-11) at the top to make copy of the graph.

Copy Button

Figure 7-11. Copy Button

7-7. Print

This function prints the graph image displayed on the window. Go to [File = Print] from the tool bar or click

the [Print] button (Figure 7-12) at the top to print the graph.

File Measure MWiew Help Print Button
B (5 B

Figure 7-12. Print Button

Also, to see the print preview condition, go to [File > Print Preview] from the tool bar. Printer can be setup

from [File = Printer Setup] on the tool bar.

7-8. Version Information

The software version information can be displayed. Go to [Help = About WSDac...] from the tool bar or

click the [?] button (Figure 7-13) at the top to see the software version information.

About Button

File Measure Wiew Help

B3 EE & e

Figure 7-13. About Button
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8. Data Analysis Software (CSVDisp)

WSDisp.exe is data analysis software, and it has main function to view the measured data (WSD) and save as
CSV format files.

8-1. Starting Data Analysis Software CSVDisp.exe

As the CSVDisp is started, the Figure 8-1 Window is displayed.

= p=n )

I

ile View Help

FHB EECE +e» 2R S| ¢

Ready C M
Figure 8-1. WSDips_V3.0.x.x.exe Window
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8-2. Start Folder View

Go to [File = Open...] from the tool bar or click the [Open] button located at the top of the window (Fig. 8-2).
When the file selecting dialog window appears, select a measurement data file and click [Open] button to

show the data.

] WSDisp
File View Help

> B & ?

Figure 8-2. Open Button for Measurement Data Files

Open
Button

8-3. Show Measurement Data

1. Displaying Data List
After the measurement data is uploaded, “Tiled Data Window” appears as shown on Figure 8-3.

Only on this window, the data can be deleted by selecting data, then right click - Delete.

(S WSDisp - [20190703.WSD] =8 [ESH 5
File(B) Edit(E) View(¥] Window(W) Help - [ =
FEB BB ?
B : B
HE [ i
] [EHNR - i E
t i
Hh it i il
SN ] : S
I 1 f T
T e T
ril ] fﬁﬁ:'\_ il
TR TTRT T TR
i b Rt el A ma e Sste s
1 T T
it {f ; i ':w ! !
. [1m I
HE e e I R e
2 2s 3 L L R

[} ==

===

Ready NUM

Figure 8-3. Tiled Data Window

2. Viewing Data Details

Double click the data shown on the Tiled Data window, or go to [View - Selected Data] on the tool bar, or

clicking the [Selected Data] button (Figure 8-4) will display the “Tiled Data window” as shown on Figure 8-5.

Selected Data
Button

Figure 8-4. Selected Data Button
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Previous/Next Data

(5 WSDisp - [20190703 e Range of | =02
File(F) Edit(E) View(y) wiW) Help g . - | &
- Integration
JDEE B e e e & 7 Value
Measured /\
Date & Time T 2019407403114 ht=grd : 275.5W/m2(300 - 1800nm)
e [ S e 30ms
. E=nzar Tamp. : - 19.5d=g
Tiled Data User Comment :;::rﬁ:lin;afﬁw
ad0.a
e 8000 Instrument
3 Information
S /\\
E 4d0.0
B
200.0 U /\\
N
1000 1200 1400 1400 1300 20aa 2200 2400
Wavel=ngth {nm)
Ready NUM
Figure 8-5. Measured Data Details Window

[Previous/Next Data]: By clicking these buttons, the data previous or next to the data currently shown is
displayed. Arrow keys (</->) on the keyboard can be also used to for this
function.

[Tile Data]: The display window can be switched back to the Tiled Data window by clicking this
button. Double clicking the displayed graph can also switch to the Tiled Data
window.

[Measured Date & Time]: The date and time of the displayed measurement taken.

[User Comment]: Displays the [User Comment] entered in the Measurement Setting.

[Range of Integration Displays the spectrum intensity integration value (W/m?) within the wavelength

Value]: range which is setup in [Integration Range] in the Measurement Setting.

[Instrument Information]:  Displays the information of [Buildup Time (Exposure Time)], [Sensor Temperature],
[Power Supply Voltage], and [with/without Sensor Cooled Drive]
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3. Displaying Specific Wavelength Data

Left clicking the mouse on the graph displayed on the graph displaying window, a cross-cursor appears as
shown on Figure 8-6, and the value of the point where cross-cursor intersection is located is displayed on the
right bottom of the graph. The cross-cursor moves as left clicking and moving the mouse; the values of each

intersection position are shown at the right bottom of the graph.

() WSDisp - [20190703.WSD] B )
File(E) Edit(E) View() Window(W) Help — [ =] %
=EHB g B e =2

1000.0__2019407/03 11:04:00 Titegrd : 2755/ m2{300 - 1800nm]
‘ ‘ —-= ME-T15 -
Espasure tme : 30ms
Sensar Tamp. : =19.5d=g
Senzar Taaling : Active
Supply Valt : 5.0V
a00 Cross Cursor
—_ a00.0 \I
E \
}'Ej Wavelength and Irradiance
3 /\\ Values are displayed.
h
:E 4000 ] [ \ WL=1092 Irr=221.0
2000 1] UI 1 .'I/\n \
Ay
1000 1200 1400 1500 1300 2000 2200 2400
e
Ready MUM

Figure 8-6. Displaying Specific Value on Graph

4. Displaying Multiple Selected Data
When selecting multiple data in a sequential range, first left click the first data in the range then as pressing
the [Shift] key, click the last data in the range. The data can be selected as shown on the Figure 8-7.

Also by using [Ctrl] key, the desired multiple data can be selected.

[ WSDisp - [20190703.WSD] ==
File(F) Edit(E) View(¥) Window(\) Help =[] =
= H B ] %

m

e
Bl |

(=
g
B

Ready MNUM

Figure 8-7. Selecting Multiple Data
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As the multiple data are selected, right click the mouse and select [Spectral Data] from the dropdown list.

The data are displayed in superimposed condition as shown on Figure 8-8.

() WsDisp - [20190703.WSD] =% Bl ===
File(E) Edit(E) View(¥) Window(W) Help — ||| =
=B B B =S

1000.0

— 209407503 11
2018407403 110
2018407403 11
2018407403 11:C
2019407403 114
—_— 2019507503 11
— 2019507/03 111
2018407403 114
2019407403 114
2019407403 114

G§00.a

ano.a ‘

400.0_L] |

Tredanaeivi/m2/um)

200.0

JVAM

|
1000 1200 1400 1500 1300 2000 2200 2400

Wavelength {nm)

Ready NUM

Figure 8-8. Superimposed Graph for Displaying Multiple Data

There are 10 colors for graphing: Red, Orange, Yellow, Yellow Green, Green, Light Green, Light Blue, Blue,
Navy and Purple, registered as default colors. If more than 10 data are selected, the colors are repeated.
Graph colors can be freely changed by opening the WSDisp.ini file as text editor and editing each RGB
values of the [COLOR TABLE]. Also by adding the number of lines, more than 10 colors can be registered.

WSDisp.ini File

[COLOR_TABLE]
#LINE_COLORO001=R,G,B
LINE_COLOR001=255,0,0
LINE_COLOR002=255,94,25
LINE_COLOR003=251,236,53
LINE_COLOR004=128,255,0
LINE_COLOR005=0,255,0
LINE_COLOR006=0,255,128
LINE_COLOR007=0,255,255
LINE_COLOR008=0,128,255
LINE_COLOR009=0,0,255
LINE_COLOR010=128,0,255
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5. Deleting Data

The data can be deleted on the tiled data list window by selecting data - right click - delete.

However, the data will not be completely deleted from the WSD file just by this procedure. In order to delete
the original data, it is required to select “Save” from the File menu. Note that the original data will not
recover by overwriting the file to save. If the original data is an important data, it is recommended to select

“Save as...” to save with different name.

8-4. Data Setting

In order to setup the range or pitch of wavelength for saving data in CSV format, contents of the data to be
saved (MS-711, MS-713, or to merge), or setup the integration range, click the [Data Settings] button. Go to
[File > CSV Settings] from the tool bar or click the [Start] button (Figure 8-9) located at the top then the
[CSV Settings] window is displayed as sown on Figure 8-10.

(&P WSDisp - [20190703.WSD]

Data Selection

Data Settings FileF) EditE) View(y) Window(W) Help
Button
[ | s
Figure 8-9. Data Setting Button
CSV Settings ﬁj
CSV Wavelength
CSV Data L Wawelength Interval Wavelength Range(nm}) Range 9
Waveform I/> 9
- A P
inm From | =" To |"‘“’
! Data Selection

Setting

[ MS-T10 W MS-711 [ MS-712 [ MS-713 |v Merge

Integration Range(nm}

Integration Range \\
Setting From | 300 7o | 2500 oK Cancel

Figure 8-10. CSV Settings Dialog Window

[CSV Data Waveform]: Specify the wavelength pitch for when the [Saving Measurement Value in CSV
Format]. By selecting the “Raw”, the data is saved with the unique wavelength
pitch of the instrument itself. By selecting “1nm”, the data is saved as linearly
interpolated in 1nm pitch.

[CSV Wavelength Range Specify the wavelength range for [Saving Measurement Value in CSV Format]; this

(nm)]: is effective only when the Wavelength Pitch is setup with “1nm”.

[Data Selection]: Saves the data of the instrument which is selected for [Saving Measurement Value
in CSV Format]. When measuring the MS-711 and MS-713 at the same time, the
combined data of MS-711 and MS-713 can be saved by selecting “Merge.”

[Integration Range]: Specify the integration range for [Saving Measurement Value in CSV Format].
Also display the specified range of integrated value on the Selected Data display
window, and the range becomes the integrated value of the saving CSV calculated
value.
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8-5. Graph Setting

When specifying the graph axis and color of line on the displayed graph, click the [Graph] button. Go to

[View = Graph Settings] from the tool bar or click the [Graph] button (Figure 8-11) located at the top then the

[Graph Settings] window will display as sown on Figure 8-12.

[ (57 WSDisp - [20190703.WSD]

File(F) Edit(E) View(¥) Window(W) Help
Graph Button
%—%'E ?

Y-Axis Setting

X-Axis Setting I.

q

Figure 8-11. Graph Button

Graph Settings @

—

-

Graph Color
1000 Graph Color Frame Color
Wimizium - <.I Grid Line
X Axis(nm) Frame Color
e [ ]
o
From |9E”:I To | %500 [v Grid Line
Tile Size

U .
" 40x30 (% 20x60 (" 160x12 (~ 240x18———_ Tiled Data Display

] Size Setting
OK | Apphy Cancel |

[Y-Axis Setting]:

[X-Axis Setting]:

[Graph Color, Frame
Color, and Grid Line]:

[Tiled Data Display Size
Setting]:
[OK, Apply, Cancel]

Buttons:

Figure. 8-12. Graph Settings Window

By checking the “Auto” checkbox, the Y-Axis scale is automatically setup. By
removing check from the “Auto” checkbox, the maximum value of Y-Axis can be
specified

Specify the X-Axis wavelength range to be displayed on graph.

By clicking the colored area, the color selection dialog window will be displayed,
and the graph and frame color can be specified as desired. The grid line of the
graph can be shown or not shown by checking or un-checking the [Grid Line]
checkbox.

Setup the size of the one measurement data to be displayed on the Tiled Data
display window.

By clicking the [OK] button, the Graph Setting window will disappear and go back
to the graph display window.

Clicking [Apply] button will allow the user to see the changes on the graph with the
Graph Setting window still opened.

[Cancel] button can cancel the setting changes on the Graph Setting.
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8-6. Data Saving

To save one or more measured data (WSD Format), to save desired measured data or calculated data in

CSV format, either go to [File] (Figure 8-13) in toolbar or use the [Save] button at the top (Figure 8-14).

i

Save Measured
Data

il

(P WSDisp - [20190703.WSD]

Edit(E) View(V] Window(W) Help

Open... Ctrl+0
Close
Save Ctrl+5

Save As...

Save as C5V(Spectral Data)
Save as CSV(Calculated Data)
CSV Settings

Print Preview
Print... Chrl+P

Printer Settings...
Recent Files

Exit

[T F [ []

[Save]:
[Save As...]:

[Save Measured Value as
CSV Format]:

[Save Calculated Value
as CSV Format]:

nmmrrTrTrTrimmmTTT T T InmT T T TR

Figure 8-13. Data Saving from Toolbar

Save the measured data (WSD Format) with same name as the original file name.
Save the measured data (WSD Format) with different name as the original file.

Save the measured time, comment, data comment, sensor type, exposure time,
applied voltage on sensor, and spectrum data per specified wavelength pitch of the
selected measurement data in CSV format.

Save the data of PAR (W/m?), PPFD (umol/m?/s), ILLUMINANCE (Ix), and integral
(W/m?) per each measured time of the selected measurement data in CSV format,

[

Overwrite Button for
Measured Data (WSD
Format)

WSDisp - [20190703.
File(F) Edit(E

Save Button for
Measured Value in
CSV Format

L]

[Save Measurement
Data]:

[Save Measurement

Value as CSV Format]:

NOTE:

opened, depending on the spreadsheet software type.

Figure 8-14. Save from the Icons

Save the measurement data (WSD format file) with same name as the original file
name.

Save the measured time, comment, data comment, sensor type, exposure time,
applied voltage on sensor, and spectrum data per specified wavelength pitch of the

selected measurement data in CSV format.

If the CSV converted data is lined more than 256, error message may appear when the file is

If such error message appears, convert into CSV

when there are less than 256 data lines.
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8-7. Graph Copy

The image of the displayed graph can be copied on the clipboard. Go to [View = Copy] from the toolbar or
click the [Copy] button (Fig. 8-15) at the top.

- WSDisp - [20190703.WSD]
File(F} Edit(E} View(\] WindowW] Help
= EH B & ?

Figure 8-15. Copy Button

Copy Button

8-8. Print

This function prints the graph image displayed on the window. Go to [File = Print] from the tool bar or click
the [Print] button (Fig. 8-16) at the top to print the graph.

(5 WSDisp - [20190703.WSD] Print Button

FiIeI[E] Edit(E] View(] Window(W] Help
= EH B [Z | & 7

Figure 8-16. Print Button

Also, to see the print preview condition, go to [File = Print Preview] from the tool bar. Printer can be setup

from [File = Printer Setup] on the tool bar.

8-9. Version Information

The software version information can be displayed. Go to [Help - About WSDisp...] from the tool bar or

click the [?] button (Fig. 8-17) at the top to see the software version information.

) WSDisp - [20190703.WSD)] About Button
File(F} Edit(E} View(\] Window(W) Help r
= H B & ?

Figure 8-17. About Button
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9. Maintenance & Troubleshooting

9-1. Maintenance

To maintain accurate measurement, it is recommended to check and do the following:

Table 9-1. Maintenance

Maintenance ltem

Clean Quartz Dome

Check Ventilation

Condition

Check Glass Dome

Condition

Check Sensor

Horizontal Position

Check Cable

Condition

Check Sensor
Fixing
Check Silica Gel

and Replace

Recalibration

Frequency |

How To Effect
Several Remove soil from the quartz | Transmittance will change and sensitivity
times per | dome with air blower or soft cloth | decreases when the quartz dome is
week and alcohol. soiled.
Several Check and make sure the | Measurement may be impacted due to
times per | ventilation is working. inefficient heat release and not being
week If any objects such as leaves are | able to control temperature. This also
caught in the fan, stop the | may lead to damaging ventilation,
operation and remove them. ventilation power supply and/or sensor.

Weekly Check for any crack or scratches | May lead to water leakage inside the

on the glass dome. sensor and cause damages to the
Sensor.

Weekly Adjust the spirit level on the | If the sensor is not leveled horizontally,
sensor to keep it in horizontal | measurements will be inaccurate by
position. affecting on cosine/azimuth response.

Weekly Check the condition of sensor | A disconnected cable may cause
and communication cables, | abnormal measurement values and
making sure they are connected | operation mistakes. Damaged cables
properly, and they do not have | may also have risks of noise or electric
any excess tensions shock.

Weekly Make sure the sensor is securely | Sensor may drop and cause damages
fixed on the mounting base. and/or injury.

Weekly Check the color of the silica gel. | Moisture gets inside the sensor while it is
If the silica gel color is changed, | used for a long period of time. Moisture
replace them. Turn the drying | saturated silica gel will lead to
cartridge in anti-clockwise to | condensation and may cause decrease
remove. Replace with new silica | of output and damage.
gel on a clear day with less
humidity.

Every 2 To maintain the best possible | Sensitivity of the sensor changes by

years measurement accuracy, it is |aging and may lead to taking inaccurate

recommended to recalibrate the
sensor every 2 years.

Contact EKO for more details and
requests for a recalibration and

maintenance service.

measurements.
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9-2. Calibration Method

It is recommended to recalibrate the instrument once every 2 years. For further information about the

calibration and recalibration, please contact EKO.

The spectroradiometer is calibrated against a NIST (National Institute of Standards and Technology)
traceable tungsten-halogen OL-FEL standard lamp at a distance of 50 cm. The standard lamp has a known
spectrum and the absolute irradiance is calibrated at several wavelengths. By measuring the
spectroradiometer's detector responsivity in counts as a function of the irradiance at corresponding
wavelengths, the sensitivity of each photo diode array pixel is converted into absolute units (W/m3/um).

The calibration function is determined by averaging 10 single measurements, measured separately for
several different wavelength intervals each with a fixed exposure time. This is to use optimal output
characteristics of the detector. Finally the calibration function is uploaded to the spectroradiometer firmware

for automatic conversion of measured count into absolute units.

The spectroradiometer is provided with a calibration certificate indicating the measurement uncertainty. The
combined uncertainty of the calibration function for each wavelength interval is based on individual uncertainties

contributed by the standard lamp, calibration set-up and spectroradiometer performance properties.

9-3. Troubleshooting

Check the following items in case of trouble with the instrument. If any questions should remain, contact

EKO for further technical support.

Table 9-2. Troubleshooting

Failure Action

- Cannot operate from PC. The cable connections for PC, power supply, and/or sensor part may be

- The data cannot be acquired. | connected incorrectly.

1) Check if the connection between PC and power supply, and power supply
and sensor.

2) Check if the power of PC and power supply is turned on.

3) Check the fuse which is in the fuse box on the power supply rear panel; make
sure it is not blown. If the fuse is blown, replace with the new fuse which is
specified on [Table 11-3. Power Supply Specification].

4) Check if the COM port connected to PC is correct.

5) Reboot the PC and check the communications and see if PC operation
recovers successfully.

6) Remove anything which could cause the noise for power supply cable and
sensor cable.

- The measured value is | 1) Shutter, spectrometer or PCB could be defected. In case there are any

abnormal damages or malfunctions, please call EKO for assistance

- S/N value of acquired data is 2) If multiple MS-713 are connected to one PC to operate, make sure to restart
not good. the software each time the instrument is switched.

- Measured value is very low. Check if the dome is clean. Refer to the chapter “Maintenance”

- The software is operating The PC and software could be defected.
abnormal. Reboot the PC then retry the software.
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10. Specification

10-1. Sensor Specifications

1. Sensor Specification

Table 10-1.Sensor Specification

Items

MS-713 ‘

Wavelength 900 to 2500nm
Wavelength Interval 1.2to 2.2nm
Spectral Resolution <20nm
Wavelength Accuracy +2nm
Temperature Dependency Within £5%
Operating Temperature -30 to +50°C

Temperature Control
(Ta: Ambient Temperature)

Light Receiving Element Part: -20°C+0.5C
(Ta = -30 to +50°C)

Exposure time

1msec to 30msec

Cosine Response

Less than +5% (within 80°)

Dome material

Synthetic Quartz

Communication

RS422 (between sensor and power supply unit)

Power supply

16VDC/5VDC

Maximum Power Consumption

95w

Dimension
(Including cover & dome)

320(p)*x325(H) mm

Weight (Sensor Part) 11kg
Table 10-2. Definitions of Terms
Definitions
Wavelength Range Range of wavelength which can be measured

Wavelength Interval Interval of wavelength for measuring data

Wavelength Resolution Full width at half-maximum when emission line is input

Wavelength Accuracy

Accuracy of wavelength

Cosine Response Difference from the theoretical value (cos 6) at zenith angle of 0° to 80°

Tolerance of change in output when ambient temperature changes between

Temperature Dependency
-30°C to +50°C.

Exposure Time Shutter open time.
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2. Power Supply Unit

Table 10-3. Power Supply Specification

Items

Power supply (Standard)

MS-713 ‘

Input : 100~240V, 50/60Hz
Output : 16VDC(80W), 5VDC(15W)

Maximum Power Consumption

190W (When DC output 95W)

Fuse

©5.2x20, 250V, 2A

Communication

RS232C(between power supply and PC)

Operating conditions

Temperature: 0 to +40°C, Humidity: 0~90%RH (No condensation)

Dimension 320(W) x 220(D) x 120(H) mm
Weight 1kg
3. Ventilation Unit
Table 10-4. Ventilation Unit Specification
Items Details

Model Number

9WG1212H101-E

Manufacturer

SANYO DENKI

Dimensions

120 x 120 x 38mm

Frame Material

Aluminum

Rated Voltage

12v

Rated Current

0.38A

Operating Voltage Range

710138V

Maximum Air Flow

2.8 m3/min.

Maximum Static Pressure

70.4 Pa

Expected Lifetime

100000hr / 60°C

Operating Environment

Temperature:-20 to +70°C

IP Classification

IP55

Terminals

Housing Model No.: 03T-JWPF-VSLE-S
Contact Model No.: SWPT-001T-P025
Manufacturer: J.S.T.MFG.CO.,LTD.

AC Adapter

Input: 100-240VAC
Output 12VDC, 1A
Model No. UIA312-12-EIAJ-4

Manufacturer: Unifive
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10-2. Software

Table 10-5. Software Specifications

Details
Applicable OS Microsoft Windows XP/Vista/7/8/10
CPU: Pentium 1GHz or more
Memory: More than 1GB
Operation Environment HHD Capacity: More than 20GB

Display Resolution:
Interface:

More than 1024 x 768
CD-ROM Drive, RS-232C port

Software Name/Versions

Measurement Software:

Data Analysis Software:

WSDac, Version: 5.0.x.x
WSDisp, Version: 5.0.x.x

Software Function Data Saving (CSV format)

Data Graphing

Data Measurement (Continuous measurement, single measurement)

EKO INSTRUMENTS CO., LTD Grating Spectroradiometer MS-713 Instruction Manual Ver5

Pg. 44




10-3. Cables

Table 10-6. Cable Specifications
Cable Name Details

Cable Type: MVVS

Diameter: 0.5mm? x 12pins
Sensor Cable Outer Diameter: ®10.4mm

Cable end: Y Terminal (1.25Y-4)

Cable Length: 10m

Plug
NJW-2012PF%
Terminals
Brown /] _ Tt 1 :{T;"H (Red)
oo | ',l : 1;”“1- L (@ V4 (oue)
Orange| | ;' :HIDJF 3 { @T.{[Red]

“ellow ' , : HI ]' J,
— ( Y4 [Blue)

| 0GND 8
Green :I:a 11,4 [Blue:l

s L) i —(C V4 (Red)

Purple WG 1 (Y4 (Blue)
| | | |

Whifep=
| |

(@) —fRlas |1 .I 'i :*12 g :@H[Red]

(@) —Rin '.I I.' I'. LLave 9 ':(§ Y 4 (Blue)

@_Black \J FARTH ]J:@H[Blue]

Figure 10-1. Sensor Cable Connections
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Table 10-7. Ventilation Unit Power Supply Cable

Cable Name Details

Cable Type: VCTF
Diameter: 0.75mm?2 x 3C

Ventilation Unit Power Supply Outer Diameter: ®4.8mm
Cable Cable ends: AD Adapter side: THB387-3P
Ventilation Unit side: NJW-163-PF
Cable Length: 10m
THB387
+12V 1 1
GND o D
3 3
Socket Plug
N
1.5m
P
&4
3
al
_'_}
>
L] 0 Lenagth:
L Standard 10m
7 Option 20m, 30m
>
N $
1.5m walg
' 3 Z| =
o) 39 +
3 2 1 [Now-163-PF
U1l
ACI00-240V

Figure 10-2. Ventilation Unit Power Supply Cable Connections
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10-4. Dimensions

1. Sensor Part

2 =# 1 0 Fixing Hole

\ . e
_\ | -
¢ 240 (Escape Hole)

Figure 10-3. Sensor Part Dimensions
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2. Power Supply

320 220
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®
~ : :
s
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Figure 10-4. MS-713 Power Supply
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10-5. Accessories List

Table 10-8. Accessories List

Standard ltems Remarks ‘

Sensor Cable

Extension: 20m, 30m, 50m

Ventilation Power Supply Cable

Extension: 20m, 30m

Silica Gel

5009

Spare Fuse

©5.2x20, 250V, 2A

Spare Ventilation

[Specification of Ventilation]
Model: 9WG1212H101-E
Manufacturer: SANYO DENKI
Size: 120 x 120 x 38mm
Rated voltage: 12V
Rated current: 0.38A
Maximum air flow: 2.8m3/min.
Maximum static pressure: 70.4 Pa
Expected Life: 100000hr / 60°C
IP Class: IP55
No ribs
Frame Materials:  Aluminum
[Specification of Terminal]
Housing Model: 03T-JWPF-VSLE-S
Contact Model: SWPT-001T-P025
Manufacturer: J.S.T.MFG.CO.,LTD.
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EKO Asia, Oceania
1-21-8 Hatagaya,
Shibuya-ku, Tokyo
151-0072 Japan

P. +81.3.3469.6711
F. +81.3.3469.6719
info@eko.co.jp
www.eko.co.jp

EKO North America

111 North Market Street,
Suite 300, San Jose,

CA 95113, USA

P. +1-408-977-7751

F. +1-408-977-7741
info@eko-usa.com
www.eko-usa.com

EKO Europe,

Middle East, Africa,
South America
Lulofsstraat 55, Unit 28,
2521 AL, Den Haag,
The Netherlands

P. +31 (0)70 3050117

F. +31 (0)70 3840607
info@eko-eu.com
www.eko-eu.com
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